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Notice

1.

13.
14,

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or 1/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V. (Max.)
and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The useris advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX140 microcontroller may be found in ‘RX140 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX140 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT5026EG
hardware. RX140 User’s Manual
Tutorial Manual Provides a guide to setting up RSK Renesas Starter Kit for R20UT5027EG
environment, running sample code and RX140 Tutorial Manual
debugging programs.
Quick Start Guide Provides simple instructions to setup the RSK Renesas Starter Kit for R20UT5028EG
and run the first sample. RX140 Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Starter Kit for R20UT5029EG
Tutorial Manual importing into the CS+ IDE. RX140 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT5025EG
RX140 Schematics
Hardware Manual Provides technical details of the RX140 RX140 Group User’s RO1UHO905EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ ngpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK Renesas Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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8. Additional Information



LENESAS

1. Overview

1.1 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code generation using the Smart Configurator.
o User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT5029EG0100 Rev.1.00 S50
Jan.17.2022 RENESAS



Renesas Starter+ Kit for RX140 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the Smart Configurator for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
o ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
o ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT5029EG0100 Rev.1.00 S50
Jan.17.2022 RENESAS




Renesas Starter Kit for RX140 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX140
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:

Windows™ 8.1: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon
Windows™ 10 / 11: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

e CS+ will show the Start Page.

Use Create New Project

‘ ) A ect be ted.
the_ GO bUtton tO Create a NeW Agzﬁg;g}wggﬂ alsgr::created by reusing the file configuration registered to an existing project.
Project.
e In the ‘Create Project’ dialog, select | | createproject *
‘RX’ from the ‘Microcontroller’ pull-
down. Microcontroller: RX ~
e In the ‘Using Microcontroller’ list Using microcontrller:
control, scroll down to ‘RX140° and 3y (Search microcontroller) Update...

expand the tree control by clicking ‘+'.
Select ‘R5F514006BxFN (80pin)'.

e Ensure that in the ‘Kind of project’ pull-
down, ‘Application(CC-RX)’ is selected.

Y REF51406ExFN(80pin)
M R5F51406BxME(48pin)
REF514034¢FJ(32pin)
£ ROSF51403AxFK(54pin)
£ R5F514034AxFL(48pin)
f RS5F51403AFM(B4pin)

Product Name:R5F51406BxFM
COn-chip ROM size[KBytes]: 256
On-chip RAM size[Bytes] 65536
Additional Information:Package=FLGPO0E0KE-B

e Choose an appropriate name and f R5F51403ANE(48pin)
location for the project, then click REFE1403ANH(32pin) v
‘Create’.
. . . Kind of project: Application{CC-RX) v
Note: this tutorial assumes the project
is named and located at the place FErEE SC_Tutorial
shown opposite. Flace: Cilworkspace ~| | Browse..
o If the folder entered cannot be found a T
‘Question’ dialog will be displayed, : : - -
Cl |Ck aYeSa ] C:\Wworkspace\SC_Tutorial\SC_Tutorial mtpj
[] Pass the file composition of an existing project to the new project
Project to be passed: Browse...
Copy composition files in the diverted project folder to a new project folder.
e CS+ will create the blank project with @ SC_Tutorial - CS+ for CC - [Project Tree]
the gtandard project tree. A ‘Smart | |q. e view Project Build [ Debug | Tool Window Help
Configurator’ node may also be & st | [ P Iy . & L
h if P | bled P E R Menuaboutdebug.] st G
shown, IT previously enabled. R —
S ) K E O &G L) & g Solution List
2 - =] .
] ‘ Q 2 @ % Smart Corfigurator Property
== 7% SC Tutorial (Project) v Product Information
E i R5F51406BxFN (Microcontroller) Version
— mart Configurator (Design Tool) ~ Smart configurator selfing
A CC-RX (Build Tool)
=, RX Simulator (Debug Tool)
: :) Program Analyzer (Analyze Tool)
-3 File

Jan.17.2022




Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX140 has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX140. When using Smart Configurator, it provides the user with a visual way of configuring the target
device, clocks, software components, hardware resources and interrupts for the project. Thereby bypassing
the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained in the RSK Web Installer

(https://www.renesas.com/rskrx140/install/cs) and may be imported into CS+ by following the steps in the
Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these moddules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the RSK.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator.

R20UT5029EG0100 Rev.1.00 RENESAS Page 11 of 70
Jan.17.2022
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: CS+.
You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator (Design Tool)” in the project tree.
RTOS configuration dialog will only appear once, on the first instance that smart configurator is opened. It will
appear as illustrated below in Figure 4-1. This project does not use RTOS, so press the ‘Finish’ button.

New Smart Configurator File

Smart Configurator Settings

Select RTOS and RTOS version

RTOS: None v

RTOS Version:

Manage RTOS Versions...

< Back Next > Cancel
Figure 4-1 RTOS setting dialog

The Smart Configurator initial view is displayed as illustrated in Figure 4-2.

Smart Configurator

File  Window Help
(=]

a8 |
@ SC_Tutorial.scfg % = B | 81MCU/MPU Package ==
A i N &l = CENE=rEREE ®) Assigned () Defauit Board
Overview information Generate Code Generate Report
- General Information o A
Overview —
Application Code
Get an overview of the features provided by Smart Configurator. e g
. Software Components g
Videos M e
°
Introduction to Smart Configurator RTOS E
rivers @
Browse related videos ‘ Device Drive £
— =
. ety
What's New MCU Hardware
Check out what's new in the latest release. e
~ Current Configuration RX140
Selected board/device: RSF51405BxFN (ROM size: 128KB, RAM size: 32KB, Pin count: 80) RSFs1405EXF
Generated location (PROJECT_LOC¥): |src¥smc_gen Edit...
Selected components:
Component - Version Configuration
© Board Support Packages. (r bsp) 7.10 r_bsp(used)
v
Overview | Board | Clocks| System Components| Pins| Interrupts > Legend
8 Console T8y By T BRI IL-YavFTyy ve-o
No consoles to display at this time. 0 items
Description - Type

Figure 4-2 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.
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Renesas Starter Kit for RX140

4. Smart Configurator Using the CS+

4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-3.

Device selection

Device selection

Board: Custom User Board s

Device: |R5F51405BxFN

Overview |Board | Clocks | System | Components Pins Interrupts

Genera

g

5 =
te Code Generate Report

& e

Figure 4-3 The ‘Board’ tabbed page

4.31 Board configuration

Make sure that ‘Custom User Board’ is selected for the ‘Board:’.

Device selection

Device selection

Board: |Cust0m User Board ™

Device: R5F51406BxFN

Figure 4-4 Select board
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

441 Clocks configuration

Figure 4-5 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 8 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-5.

Clocks configuration “ -
9 Generate Code Generate Report
vee: | 33 (V) (Actual value: 3.3)
PLL it
Main clock e
Frequency Division:
& Resona tor v
I x1 - I
Frequency: | 8 (MHz) o
Frequency Multiplication: SCKCR (FCKI30) FlashlF clack (FCLK]
wattime: [ g192 o+ || a0as | (us) = 1 (Mz)
SCKCR (ICK[3:0D) System clock {ICLK)
>—|j x1 48 (MHz)
Sub-clack
SCKCR (PCKB[3:0]) Peripheral module clock (PCLKB)
x1/2 v 24 (MHz)
SCKCR (PCKD[3:0]) Peripheral module clock (PCLKD)
1 43 (MH2)
HOCO clock
X174
LOCO clock
&)
CKOCR (CKODIV[2:0]) CLKOUT pin
x1/8
IWDT-dedicated low-speed clock ‘
CANMCLK/CACMCLK
g (MHz)

Overview Board System|Components | Pins|Interrupts

Figure 4-5 The ‘Clocks’ tabbed page
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.5 The ‘System’ tabbed page

Set the On-chip debug setting mode on the ‘System’ tabbed page.

(ol =

System conflguratlon Generate Code Generate Report

~ On-chip debug setting
Debug interface setting
(® Unused O FINE

Overview Board |Clocks Components| Pins Interrupts

Figure 4-6 The ‘System’ tabbed page

451 On-chip debug setting

The On-chip debug settings set the interface used for debugging. For the RSKRX140 CPU board, select FINE
as shown in Figure 4-7.

System configuration

~ On-chip debug setting

Debug interface setting

O Unused @

Figure 4-7 Debug interface setting
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.6 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

Software component configuration

Components = ::: »  Configure
W
type filter text
v (= Startup
w = Generic
& rbsp

Overview | Board | Clocks | System Eomponent;! Pins | Interrupts
Figure 4-8 Components page

4.6.1 Add a software component into the project

Smart Configurator supports four types of software components: Startup, Drivers, Middleware and Application.
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ W icon.

Software component configuration

Components b =) v

type filter text

v [= Startup
w [ Generic
& rbsp

Figure 4-9 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Mew Component

Software Component Selection
Select component from those available in list .dj
Type All ~
Function o
Filter
1

Figure 4-10 Add a Software component (2)
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Renesas Starter Kit for RX140

4. Smart Configurator Using the CS+

4.6.2 8-Bit Timer

TMRO will be used as an interval timer for generation of accurate delays. Select ‘8-Bit Timer’ as shown in

Figure 4-11 below then click ‘Next'.

New Component O X

Software Component Selection

Select component from those available in list

&

Category Drivers

# Clock Frequency Accuracy Measurement...
# Comparator

H Compare Match Timer

# Complementary PWM Mode Timer

# Continuous Scan Mode S12AD

# CRC Calculator

Function |All v
Filter

Components - Short Name Type Version A~
# 8-Bit Timer Code Generator 190 |
B Buses

Code Generator ~ 1.10.0
Code Generator ~ 1.10.0
Code Generator ~ 1.8.0

Code Generator ~ 2.2.0

Code Generator ~ 1.10.0
Code Generator ~ 1.12.0
Code Generator ~ 1.10.0

Show only latest version
Hide items that have duplicated functionality
Description

This software component generates two units (unit 0, unit 1) of an on-chip 8-bit timer (TMR)
module that comprise two 8-bit counter channels, totaling four channels.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | | Einish | Cancel

Figure 4-11 Select 8-Bit Timer

Ensure that the ‘Configuration name’ updates to ‘Config. TMRO’ as shown in Figure 4-12 below then click

‘Finish’.

New Component O X

Add new configuration for selected component

#

8-Bit Timer

Configuration name: | Config_TMRO

Count mode: 8 bit b
Resource: TMRO b
@ < Back Next > Cancel

Figure 4-12 Ensure Configuration name - TMRO

R20UT5029EG0100 Rev.1.00
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Renesas Starter Kit for RX140

4. Smart Configurator Using the CS+

In ‘Config_ TMROQ’, configure TMRO as shown in Figure 4-13. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

« Config_TMRO

TMOO output setting
[JEnable TMOO output

Components e ed |2 E B33 v Configure
bl Count setting
type filter text Clock source [Pcik/1024 V| [234315 (kHz)
= ~
v © Startup Counter clear |Cleared by compare match A v]
v = Generic
5 Compare match A value (TCORA) 1 ms i (Actual value: 0.981333)
« r_bsp
rivers ompare match B value ms ctual value: 0.981
v =D Comp h B value (TCORB) 1 (Actual value: 0.981333)
~ = Timers

No change
No change
Interrupt setting
Enable TCORA compare match interrupt (CMIAQ)
[_]Enable TCORB compare match interrupt (CMIBO)
] Enable TCNT overflow interrupt (OVI10)
Priority ILeveI 10

Figure 4-13 Config_TMRO setting

4.6.3 Compare Match Timer

CMTO and CMT1 will be used as timers in de-bouncing of switch interrupts.

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ as shown in Figure 4-14 below then click ‘Next'.

New Component O X

Software Component Selection tlj

Select component from those available in list

Category |Drivers Vl
Function |All v
Filter ‘ ‘

Components - Short Name Type Version A~

 8-Bit Timer Code Generator ~ 1.9.0

B Buses Code Generator 1.10.0

# Clock Frequency Accuracy Measurement... Code Generator ~ 1.10.0

B Comparator Code Generator 1.8.0

# Compare Match Timer Code Generator  2.2.0 |

# Complementary PWM Mode Timer Code Generator ~ 1.10.0

& Continuous Scan Mode S12AD Code Generator ~ 1.12.0

# CRC Calculator Code Generator 1100,
Show only latest version
Hide items that have duplicated functionality
Description

This software component provides configurations for 16-bit/32-bit timer with module

CMT/CMTW and can generate interrupts at set intervals.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | | Einish | Cancel

Figure 4-14 Select Compare Match Timer
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Renesas Starter Kit for RX140

4. Smart Configurator Using the CS+

Ensure that the ‘Configuration name’ updates to ‘Config_ CMTQ’ as shown in Figure 4-15 below then click

‘Finish’.

New Component O X

Add new configuration for selected component

Compare Match Timer

s

Configuration name: | Config_CMTO
Resource: CMTO v
@ < Back Next > Cancel

Figure 4-15 Ensure Configuration name — CMTO0

Navigate to the ‘Config_CMTO’ and configure CMTO as shown in Figure 4-16. This timer is configured to
generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.

£ e B

Components

»
W w

type filter text

~ & Startup
v (= Generic

~

@ r_bsp
~ & Drivers
v = Timers
« Config_CMTO
@ Config TMRO

# ¥ Configure

Count clock setting

~ | (Actual value: 20)

O PCLk/s O PCLK/128 O PCLK/512
Compare match setting

Interval value |ZO | |m5
Register value (CMCOR) (14999 |
Compare match interrupt (CMI0)

Priority ILeveI 10 Vl

Figure 4-16 Config_CMTO setting
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Renesas Starter Kit for RX140

4. Smart Configurator Using the CS+

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->

Resource, select ‘CMT1’ as shown in Figure 4-17 below.

New Component O X

Add new configuration for selected component

Compare Match Timer

=5}

Configuration name: ‘ Config_CMTO1

Resource: ‘CMTO

h ‘

< Back Next >

Cancel

CMTO

Figure 4-17 Select Resource — CMT1

Ensure that the ‘Configuration name’ updates to ‘Config_ CMT1’ as shown in Figure 4-18 below then click

‘ H H ’
Finish'.
New Component O X
Add new configuration for selected component tlj
Compare Match Timer
Configuration name: |Config_CMT1
Resource: CMT1 v
@ < Back Next > Cancel

Figure 4-18 Ensure Configuration name — CMT1

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-19. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in

this tutorial.
Components e eh 1% B B3 ¥ Configure O]
hd Count clock setting
type filter text | Orcws OrcLks32 O PcLK/128
v (= Startup ~ Compare match setting
¥ & Generic Interval value IZOO I |ms ~ | (Actual value: 200)
“ rbsp Register value (CMCOR 9374 \
« & Drivers egister value ( )
v & Timers Compare match interrupt (CMI1)
& Config_CMTO Priority iLevel 10 ~|
« Config_CMT1
@ Config_TMRO
Figure 4-19 Config_CMT1 setting
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.6.4 Interrupt Controller

Referring to the RSK schematic, SW1 is connected to IRQ1(P31) and SW2 is connected to IRQ2 (P32). SW3

is connected to IRQ4(P16) and ADTRGON. This tutorial uses ADTRGOn, which will be configured later in
section 4.6.8.

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Interrupt Controller’ as shown in Figure 4-20 then click ‘Next’.

New Component O X

Software Component Selection t]j

Select component from those available in list

Category |Driver5 Vl
Function | All N
Filter ‘ ‘
Components - Short Name Type Version ~
B Dead-time Compensation Counter Code Generator 1.10.0

& Event Link Controller Code Generator ~ 1.8.0

# Flash API for RX100, RX200, RX600. and... r_flash_rx Firmware Integr...  4.81

# Group Scan Mode S12AD Code Generator ~ 1.11.0

#12C Master Mode Code Generator ~ 1.11.0

#12C Slave Mode Code Generator ~ 1.10.0
 Interrupt Controller Code Generator ~ 2.2.0 I

# Low Power Consumption Code Generator ~ 2.2.0 W

Show only latest version
Hide items that have duplicated functionality
Description

Interrupt Controller configures the interrupt requests generated by ICU: Software interrupt, NMI
pin interrupt and IRQ External pin interrupts.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | | Finish | Cancel

Figure 4-20 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ICU’ as shown in Figure 4-21
below then click ‘Finish’.

New Component O X

Add new configuration for selected component tb

Interrupt Controller

Configuration name: | Config_ICU

Resource: ICU 7

@ < Back Next > Cancel

Figure 4-21 Select resource — ICU
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Renesas Starter Kit for RX140

4. Smart Configurator Using the CS+

Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-22

below.
Components ed % B B3 v Configure @
= Software interrupt setting
‘type filter text [Isoftware interrupt Priority [Level 15 (highest)
v & Startup ~
v & Generic NMI pin interrupt setting
& r_bsp [INMI pin interrupt Detection type |Falling edge Digital filter |No filter {(MHz)
v & Drivers IRQO setting
¥ & Interrupt
& Config_ICU [J1rQo Detection type |Falling edge Digital filter |No filter (MHz)
v & Timers Priority [Level 15 (highest)
« Config CMTO .
& Config CMT IRQ1 setting
@ Config_TMRO \RO‘\ Detection type |Falling edge ~| Digital filter No filter {(MHz)
Priority Level 15 (highest) >
IRQ2 setting
\RQZ Detection type :Falling edge ~| Digital filter No filter (MHz)
Priority Level 15 (highest) ™
IRQ3 setting
[Tira3 Detection type |Low level Digital filter |No filter {(MHz)
Priority [Level 15 {highest)
v IRQ4 setting
R4 Detection type |Low level Digital filter |No filter {MHz)
Priority |Level 15 (highest)
IRQS5 setting
[R5 Detection type |Low level Digital filter |No filter (MHz)
Priority [Level 15 (highest)
IRQ6 setting
[ JIrRQ6 Detection type |Low level Digital filter |No filter {MHz)
Priority [Level 15 (highest)
IRQ7 setting
[JIrRQ7 Detection type |Low level Digital filter |No filter (MHz)
Priority [Level 15 (highest)
Figure 4-22 Config_ICU setting
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.6.5 Ports

Referring to the RSK schematic, LEDO is connected to P21, LED1 is connected to P04, LED2 is connected to
P06 and LED3 is connected to PO7. PB2 is used as one of the LCD control lines, together with PE4, PC7 and
PC6.

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Ports’ as shown in Figure 4-23 then click ‘Next'.

New Component O X

Software Component Selection t]j

Select component from those available in list

Category |Driver5 ™ |
Function |All v
Filter ‘ ‘
Components - Short Name Type Version ~
# Normal Mode Timer Code Generator ~ 1.11.0

# Phase Counting Mode Timer Code Generator ~ 2.3.0

H Port Output Enable Code Generator ~ 1.10.0

# Ports Code Generator _ 2.3.0 I

& PWM Mode Timer Code Generator ~ 1.11.0

# Real Time Clock Code Generator ~ 1.7.0

B SCI/SCIF Asynchronous Mode Code Generator ~ 1.11.0

# SCI/SCIF Clock Synchronous Mode Code Generator 1.11.0 W

Show only latest version
Hide items that have duplicated functionality
Description

This software component provides configurations for General Purpose Input/Qutput. Common ~
features such as reading, writing, and setting the direction of ports and pins can be configured.

LI P S T ' Sy S PO

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | | Finish | Cancel

Figure 4-23 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-24
below then click ‘Finish’.

New Component O X

Add new configuration for selected component t]j

Ports

Configuration name: | Config_PORT

Resource: PORT R

@ < Back Next > Cancel
Figure 4-24 Select resource — PORT
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

Tick the tickboxes for ‘PORTQ’, ‘PORT2’, PORTB’, ‘PORTC’ and ‘PORTE’ as shown in Figure 4-25 below.

-

Components s ed /% B &5 ¥ Configure

-

Port selection PORTO PORT2 PORTB PORTC PORTE

type filter text

¥ &= Startup ~
v & Generic [Arormo [IPORT1
v r b
.?' oep [Zlport2 [1PORT3
~ = Drivers
v = Interrupt [ 1poORT4 [ 1PORT5
@ Config_ICU
v 1/0 Ports [J PORTA [“IrorTe
« Config_PORT PORTC [JPORTD
~ & Timers
& Config CMTO [ 1PORTG
« Config_CMT1
" PORTH PORTJ
@ Config_TMRO u N

Figure 4-25 Select Port selection

Navigate through each of the ‘PORTX’ tabs, configuring these four 1/O lines and LCD control lines as shown in
Figure 4-26, Figure 4-27, Figure 4-28, Figure 4-29 and Figure 4-30 below. Tick the tickboxes for ‘Out’ and
tick ‘Output 1’ the tickboxes except for PC6 under the ‘PORTC’ tab. Start with the 'PORTOQ' tab.

Components 4% B @3 vy Configure @
wE Port selection PORT2 PORTB PORTC PORTE
type filter text ‘
~ = Startup ~
~ = Generic DApp\y toall
% r bsp Unused GPIO In Out Pull-up Output 1
~ & Drivers
P03
v & Interrupt
& Config_ICU ® Unused GPIO Oin- Oout [ Pull-up Output 1
=3
v V'ocpo:‘t's PORT Fod
« Config_|
v & Timers (O Unused GPIO O In Pull-up
& onteT o
@ Confi
e Conf(:iTMRO ® Unused GPIO OIn O out [ Pull-up Output 1
P06
(O Unused GPIO O In Pull-up
PO7
O Unused GPIO OIn Pull-up
Figure 4-26 Select PORTO0 tab
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4. Smart Configurator Using the CS+

Select ‘PORT2’ tab.

Components ed 2 B B3 ¥ Configure @
%=
: Port selection PORTQ | PORT2 |PORTB PORTC PORTE
type filter text |
~ &= Startup A
v = Generic 0 Apply to all
% r_bsp Unused GPIO In Out Pull-up  |[CMOS output Output 1
~ = Drivers ’
P20
v & Interrupt
& Config_ICU ® Unused GPIO OIn O out [ Pull-up |CMOS output ~ Output 1
=3
’ V‘OCPOI:'S PORT Par
« Config_|
v & Timers O UnusedGPio Oin Pull-up  |CMOS output ~
@ Contg s
« Config ¢
& Config TMRO ®uUnusedGPlo Oin Oout [IPullup  CMOS output 7 Output 1
p27
®UnusedGPIo Oin Oout [IPullup  CMOS output 4 Output 1
Figure 4-27 Select PORT2 tab
Select ‘PORTB tab.
Components e ed %2 B B3 v Configure O]
%
Portselection PORTO PORT2 [PORTB |PORTC PORTE
type filter text
~ = Startup ~
v (= Generic U Apply to all
% rbsp Unused GPIO In Qut Pull-up  |CMOS output Output 1
~ & Drivers PEO
v & Interrupt
& Config_ICU ®UnusedGPI0. O'in Oout [ Pull-up  |CMOS output ™ Output 1
=
v \/E) Ports .
« Config_PORT
v = Timers ®UnusedGPI0. O'in- Oout [ Pull-up  |CMOS output ™ Qutput 1
\’. Config_CMTO PR
« Config CMT1
& Config TMRO O Unused GPIO Pull-up  |CMOS output ~
PB3
®uUnusedGPIo Oin O out [JPull-up  CMOS output 5 Output 1
P p p
PB4
®UnusedGPI0 Oin G out [JPull-up  CMOS output & Output 1
PB5
® Unused GPIO O'in- O out [ Pull-u CMOS output ~ Output 1
P p p
v
PB6
® Unused GPIO O'In O out [ Pull-up  |CMOS output ~ Output 1
PB7
® Unused GPIO O'In O out [ Pull-up |CMOS output &7 Output 1
Figure 4-28 Select PORTB tab
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Select ‘PORTC'’ tab.

Components e %2 B B3 Y Configure @
%z
Port selection PORTO PORT2 PORTB
type filter text |
~ = Startup ~
v = Generic 0 Apply to all
% rbsp Unused GPIO In Out Pull-up |CMOS output Output 1
~ & Drivers PCO
~ & Interrupt
& Config ICU ® Unused GPIO O'In Oout [ Pull-up  CMOS output Qutput 1
v &= 1/0 Ports PC1
« Config_PORT
v & Timers @ Unused GPIO O In O Out D Pull-up  CMOS output Qutput 1
= Gontig ot
« Config_
& Config TMRO @ Unused GPIO O In O Out D Pull-up  CMOS output Qutput 1
PC3
®unusedGPlo Oin Oout [J Pull-up |CMOS output Qutput 1
PC4
®@unusedGPlo Oin Oout [J Pull-up |CMOS output Qutput 1
PC5
®UnusedGPIO. O'in- O out [JPull-up  CMOS output Qutput 1
v
PCo
O Unused GPIO. O In Pull-up  |CMOS output [Joutput 1
PC7
O Unused GPIO. O In Pull-up  |CMOS output
Figure 4-29 Select PORTC tab
Select ‘PORTE tab.
Components e %2 B ®3 Y Configure @
%z
Port selection PORTO PORT2 PORTB PORTC
type filter text |
~ & Startup ~
¥ (= Generic U Apply to all
% rbsp Unused GPIO In Out Pull-up Output 1
~ & Drivers PED
v & Interrupt
& Config_ICU ®unusedGPlo Oin Oout [J Pull-up |CMOS output Qutput 1
v =1/0 Ports PET
« Config_PORT
v @& Timers ®@unusedGPlo Oin Oout [J Pull-up |CMOS output Qutput 1
« Config_CMTO PE>
« Config_CMT1
& Config TMRO ®@uUnusedGPI0. Oin Oout [ Pull-up |CMOS output Qutput 1
PE3
®UnusedGPIO. O'in O out [JPull-up  CMOS output Output 1
PE4
O unused GPIO. O In Pull-up
PES
®uUnusedGPIo Oin Oout [Pull-up Output 1
v
Figure 4-30 Select PORTE tab
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4.6.6 SCI/SCIF Asynchronous Mode

In the RSKRX140, SCI1 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as shown

in the schematic.

Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SCI/SCIF Asynchronous Mode’ as

shown in Figure 4-31 then click ‘Next’.

New Component O X

Software Component Selection BT
Select component from those available in list
Category |Driver5 Vl
Function | All N
Filter ‘ ‘
Components - Short Name Type Version ~
H# SCI/SCIF Asynchronous Mode Code Generator 1.11.0 I
8 SCI/SCIF Clock Synchronous Mode Code Generator ~ 1.11.0
H Single Scan Mode S12AD Code Generator ~ 2.4.0
# Smart Card Interface Mode Code Generator ~ 1.11.0
H# SPI Clock Synchronous Mode (3-wire m... Code Generator ~ 1.11.0
# SP| Operation Mode (4-wire method) Code Generator 1.9.0
HVoltage Detection Circuit Code Generator ~ 1.10.0
# Watchdog Timer Code Generator 1100,
Show only latest version
Hide items that have duplicated functionality
Description
This software component provides configurations for SCI(SCIF) single(multi-processor)
asynchronous mode.
Download the latest FIT drivers and middleware
Configure general settings...
@ < Back | Next > | | Finish | Cancel

Figure 4-31 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as

shown in Figure 4-32 below.

New Component O X

Add new configuration for selected component

s

SCI/SCIF Asynchronous Mode

Configuration name: ‘ Config_SCI1

Work mode: Transmission b
FEssas Transmission

Reception

Transmission/Reception

Multi-processor Transmission

Multi-processor Reception

Multi-processor Transmission/Reception
@ < Back Next > Cancel

Figure 4-32 Select Work mode — Transmission/Reception
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Ensure that the ‘Configuration name’ is set to ‘Config_SCI1’ as shown in Figure 4-33 below then click ‘Finish’.

New Component O

Add new configuration for selected component

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCI1

Transmission/Reception

Work mode:
Resource: SCI b
@ < Back Next > Cancel

Figure 4-33 Ensure Configuration name - Config_SCI1
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

Configure SCI1 as shown in Figure 4-34. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components e ed 1% B B3 Y Configure @
e Start bit edge detection setting
type filter text ‘ O Low level on RXD1 pin |@ Falling edge on RXD1 pin
v & Startup " Data length setting
v & Generic O 9 bits ® 8 bits O 7 bits
% r_bsp
v & Drivers Parity setting
v & Interrupt (® None O Even O odd
« Config_ICU Stop bit length setting
¥ &1/0 Ports ® 1 bit O 2 bits

« Config_PORT

. Transfer direction settin
~ = Communications 9

& Config_sCI1 (® LSB-first (O MsB-first
~ & Timers Data inversion setting
« Config_CMTO (® Normal O Inverted

« Config_CMT1

. Instant transmission setting
« Config_TMRO

D Enable instant transmission

Transmitter output setting

(® Normal O Inverted
Receiver input setting
(® Normal O Inverted
Transfer rate setting
hd Transfer clock Internal clock v
Base clock 16 cycles for 1-bit period N
Bit rate 19200 ~| (bps) (Actual value: 19230.769, Error: 0.16%)
] Enable modulation duty correction
SCK1 pin function SCK1 is not used ~
Transfer timing adjustment setting
[ Adjust transmit signal transition Does not change the waveform
0 Adjust receive data sampling 3 clocks later than default point
Noise filter setting
[JEnable noise filter
Clock signal divided by 1 24000000
Hardware flow control setting
(® None Ocrst# ORTS1#
Data match detection setting
[JEnable data match detection
0x00
Data handling setting
Transmit data handling Data handled in interrupt service routine v
Receive data handling Data handled in interrupt service routine v
Interrupt setting
Enable reception error interrupt (ERI1)
TXI1, RXI1, TEN, ERIT priority Level 15 (highest) N
Callback function setting
Transmission end Reception end Reception error
Figure 4-34 Config_SCI1 setting
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.6.7 SPI Clock Synchronous Mode

In the RSKRX140, SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as
shown in Figure 4-35 then click ‘Next'.

New Component O X

Software Component Selection t]j

Select component from those available in list

Category |Driver5 Vl
Function |All b
Filter ‘ ‘
Components - Short Name Type Version ~
H# SCI/SCIF Asynchronous Mode Code Generator 1.11.0
8 SCI/SCIF Clock Synchronous Mode Code Generator ~ 1.11.0
H Single Scan Mode S12AD Code Generator ~ 2.4.0
8 Smart Card Interface Mode Code Generator  1.11.0
H# SPI Clock Synchronous Mode (3-wire m... Code Generator __ 1.11.0 I
# SP| Operation Mode (4-wire method) Code Generator 1.9.0
HVoltage Detection Circuit Code Generator ~ 1.10.0
# Watchdog Timer Code Generator 1100,
Show only latest version
Hide items that have duplicated functionality
Description
This component provides clock synchronous operation of RSPI or SCI (Simple SPI bus). It includes A
4 transfer modes: Slave transmit/receive, Slave transmit, Master transmit/receive and Master v

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | | Finish | Cancel

Figure 4-35 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown

in Figure 4-36 below.

Add new configuration for selected component tlj

SPI Clock Synchronous Mode (3-wire method)

Configuration name: | Config_RSPIO

Operation: Slave transmit/receive ~

RssEEs: Slave transm!t/recel\/e
Slave transmit only

Master transmit/receive
Master transmit only

@ < Back Next > Cancel

Figure 4-36 Select Operation — Master Transmit
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4. Smart Configurator Using the CS+

In ‘Resource’, select ‘SCI6" as shown in Figure 4-37 below.

New Component O X

Add new configuration for selected component

#

SPI Clock Synchronous Mode (3-wire method)

Configuration name: | Config_RSPIO

Operation: Master transmit only

Resource: RSPIO

RSPIO
sci
SCIS

SCI8
SCI9
scl2

SCl6

@ < Back Next >

Figure 4-37 Select Resource — SCI6

Ensure that the ‘Configuration name’ is set to ‘Config_SCI6’ as shown in Figure 4-38 below then click ‘Finish’

New Component O X

Add new configuration for selected component

#

SPI Clock Synchronous Mode (3-wire method)

Configuration name: | Config_SCI6

Operation: Master transmit only bd
Resource: 5Cl6 w
@ < Back Next > Cancel

Figure 4-38 Ensure Configuration name - Config_SCI6
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

Configure SCI6 as shown in Figure 4-39. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 6000 kbps. All other settings remain at their defaults.

Components eaed % B ® 3 v Configure
il Transfer direction setting
type filter text  Otseint @ MSB-first
v (= Startup ~ . . .
v & Generic Data inversion setting
& 1 bsp (® Normal O Inverted
v = Drivers

Transfer speed setting
¥ & Interrupt

& Config_ICU Transfer clock Internal clock (SCK6 pin functions as clock output pin) v
v &1/0 Ports Bit rate 6000 (kbps) (Actual value: 6000, Error: 0%)

« Config_PORT

. [J Enable modulation duty correction
v = Communications

& Config_SClI1 Clock setting

« Config_SCI6 [ Enable clock delay [_Ienable clock polarity inversion
v = Timers

& Config_CMTO Data handling setting

@ Config_CMT1

Transmit data handling Data handled in interrupt service routine hd
& Config_TMRO

Interrupt setting

TXI16, TEI6 priority Level 15 (highest) hd

Callback function setting
Transmission end

Figure 4-39 Config_SCI6 setting

R20UT5029EG0100 Rev.1.00 REN ESNS Page 32 of 70
Jan.17.2022



Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

4.6.8 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK. The conversion start trigger will be via the pin connected to SW3. Click the

‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘Single
Scan Mode S12AD’ as shown in Figure 4-40 then click ‘Next'.

New Component O X

Software Component Selection t]j

Select component from those available in list

Category |Driver5 Vl
Function |All b
Filter ‘ ‘
Components - Short Name Type Version ~
H# SCI/SCIF Asynchronous Mode Code Generator 1.11.0
# SCI/SCIF Clock Synchronous Mode Code Generator ~ 1.11.0
# Single Scan Mode S12AD Code Generator  2.4.0 I
# Smart Card Interface Mode Code Generator ~ 1.11.0
H# SPI Clock Synchronous Mode (3-wire m... Code Generator ~ 1.11.0
# SP| Operation Mode (4-wire method) Code Generator ~ 1.9.0
HVoltage Detection Circuit Code Generator ~ 1.10.0
# Watchdog Timer Code Generator 1100,
Show only latest version
Hide items that have duplicated functionality
Description
This software component provides single scan mode configurations for 12-Bit A/D Converter
which the analog inputs arbitrarily selected are converted for only once in ascending channel order.

Download the latest FIT drivers and middleware

Configure general settings...

@ < Back | Next > | | Finish | Cancel

Figure 4-40 Select Single Scan Mode S12AD

Ensure that the 'Configuration name' is'Config_S12AD0' as shown in Figure 4-41 below then click ‘Finish’.

New Component O X

Add new configuration for selected component tlj

Continuous Scan Mode S12AD

Configuration name: |Config_S12AD0

Resource: S12AD0 b
@ < Back Next > Cancel

Figure 4-41 Ensure Configuration name - S12AD0
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

Configure S12AD0 as shown in Figure 4-42 and Figure 4-43. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings
remain at their defaults.

Components d % B B 3 v Configure
.
~ Basic setting
type filter text
Note
¥ & Startup A . .
. When the 12-bit A/D converter is used, output fram port 4 should not be used.
v & Generic
% rbsp Analog input channel setting
~ & Drivers ) [1aNo01 [Janoo2 [[] AN003 [ AN0O4
v @& Interrupt [JANOOS [1aNoos [JANo07 ] ANoos [JANoO16
« Config_ICU [Jano17 [JANo18 [Jano19 [JaN020 [JaNo21
v © A/D Converter [JaN024 [JAN025 [JANO026
« Config_S12ADO
v @ 1/0 Ports Conversion start trigger setting
« Config_PORT Start trigger source |A/D conversion start trigger pin |
v & Communications .
& Config SCI1 Interrupt setting
@ Config SCI6 Enable AD conversion end interrupt (S12ADI0)  Priority  Level 15 (highest)
v & Timers
& Config_CMTO ~ Advance setting
« Config CMT1 Add/Average AD value setting
« Config TMRO [] ANooO ANOO ANOO2 ANOO3 ANOO4
ANO0O5 ANO006 AN007 ANO08 ANO16
ANO17 ANO18 ANO19 AN020 ANO021
AN024 ANO025 ANO026
A/D conversion select
(® High-speed O Low-current
Conversion cycle select
(®) 3 cycles per bit (O 2 cycles per bit
High-Potential reference voltage setting
® Avceo O VREFHO
Low-Potential reference voltage setting
® Avsso O VREFLO
Self diagnosis setting
Mode Unused hd
ov
Disconnection detection assist setting
Charge setting Unused 82
2 ADCLK
Figure 4-42 Config_S12AD0 setting (1)
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4. Smart Configurator Using the CS+

Data registers setting

Data placement

Automatic clearing

Addition/Average mode select

Addition count

Window function setting

(® Disable

Window A/B operation setting

[ Enable comparison window A

A/D comparison A setting

Reference data 0 for comparison

Reference data 1 for comparison
Use comparator for ANOOO
Use comparator for AN0O1
Use comparator for AN002
Use comparator for ANOO3
Use comparator for AN0O4
Use comparator for ANOOS
Use comparator for ANOO6
Use comparator for ANOO7
Use comparator for AN0OS
Use comparator for ANO16
Use comparator for ANO17
Use comparator for ANO18
Use comparator for ANO19
Use comparator for AN020
Use comparator for AN021
Use comparator for AN024
Use comparator for AN025
Use comparator for AN026

A/D comparison B setting

Reference data 0 for comparisan

Reference data 1 for comparison

Comparison B channel

Input sampling time setting

|Right7a|ignment v|

|Disab|e automatic clearing v |

|Addition mode v|
|1-time v|
O Enable

[ Enable comparison window B

0

0

Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

0
0
Unused

Reference data 0 > A/D-converted value

AN000/Self-diagnosis 0.183 (us) (Actual value: 0.188)
ANOO1 0.183 (ps)  (Actual value: 0.188)
ANOO2 0.183 (ps)  (Actual value: 0.188)
AN0O3 0.183 (ps)  (Actual value: 0.188)
ANOO4 0.183 (ps)  (Actual value: 0.188)
ANQOS 0.183 (bs)  (Actual value: 0.188)
ANOO6 0.183 (ps)  (Actual value: 0.188)
ANOO7 0.183 (ps)  (Actual value: 0.188)
ANOOS 0.183 (ps)  (Actual value: 0.188)
ANOTE-ANOZ1, ANO24-AN026 0.183 1s)  (Actual value: 0.188)

(First cycle conversion time: 1.104ps)

Event link control setting

|On completion of all scans v ‘

Figure 4-43 Config_S12AD0 setting (2)

ELC scan end event generation condition
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4. Smart Configurator Using the CS+

4.7 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the

pins can be changed at Pins page.

4.71

To change the pin assignment of a software component in Pin Function list. Click

by Software Components.

Pin configuration

Hardware Resource

B %

s

= LvD2

% Clock frequency accuracy measurement circuit

v % Multi-function timer pulse unit 2
= MTUO
= MTU1
= MTU2
= MTU3
= MTU4
= MTUS
% Port output enable 2
i# Realtime clock
¥ i 8-bit timer
= TMRO
= TMR1

Pin Function Pin Number

Overview Board | Clocks |System Components Interrupts

Figure 4-44 The ‘Pins’ tabbed page

Change pin assignment of a software component

52

to change view to show

Pin configuration

Hardware Resource

Type filter text

Figure 4-45 Change view to show by Software Components

R20UT5029EG0100 Rev.1.00
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

Select the Config_SCI1 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD1 and TXD1 are checked and Assignment column of RXD1 is P30 and TXD1 is P26
as shown in Figure 4-46.

Pin configuration o -

9 Generate Code Generate Report
Software Components = %lé@  Pin Function RNEIR S
|Type filter text ‘ ‘type filter text (* = any string, ? = any character) ‘ All v

v &rbsp Ena.. Function  Assignment Pin Num... Directi... Remarks Comments
¥ rbsp [] crs1# # Not assigned # Not assigi None

¥ & 8-Bit Timer ] RTS1# # Not assigned # Not assigi None
* Config TMRO RXD1 [~ P30/MTIOCAB/TMRI3/POE8 #/RXD 1/SMISO1/SSCL1/TS2/1] # 18 !

¥ & Compare Match Timer ] sck1 # Not assigned # Not assigl None
* Config_CMTO TXD1 [ P26/MTIOC2A/TMO 1/LPTO/TXD1/SMOSI1/SSDA1/TS4 ] # 20 o

= Config_CMT1

¥ & Interrupt Controller
« Config_ICU

v & Ports
« Config_PORT

v & SCI/SCIF Asynchronous Mode
« Config_SCI1

v 2 SPI Clock Synchronous Mode (3-wire method)
« Config_SCI6

v & Continuous Scan Mode S12AD
« Config_S12AD0

Pin Function Pin Number

Figure 4-46 Configure pin assignment - Config_SCI1

Select the Config_SCI6 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is PB3, SMOSI6 is PB1
as shown in Figure 4-47.

Software Components B 1% &&  Pin Function RANEHR e
Type filter text ‘ ‘type filter text (* = any string, ? = any character) ‘ All ~
v Lrbsp Ena.. Function  Assignment Pin Num... Directi.. Remarks Comments
“ rbsp SCKé [7 PB3/MTIOCOA/MTIOCAA/TMOO/POE3#/LPTO/SCK6/TS22]# 45 10

v & 8-Bit Timer [] smisos 7 Not assigned # Not assigi None
= Config_TMRO SMOSI6 |7 PB1/MTIOCOC/MTIOCAC/TMCIO/TXD6/SMOSI6/SSDAG/TY » 47 10

~ & Compare Match Timer [] sse# # Not assigned # Not assigi None

= Config CMTO
= Config_CMT1

¥ X Interrupt Controller
& Config_ICU

v Z Ports
« Config_PORT

¥ & SCI/SCIF Asynchronous Mode
« Config SCI

v % SPI Clock Synchronous Mode (3-wire method)
« Config_SCI6

v X Continuous Scan Mode S12AD
@ Config_S12AD0

in Function Pin Number

Figure 4-47 Configure pin assignment - Config_SCI6
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Renesas Starter Kit for RX140 4. Smart Configurator Using the CS+

Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQ1 to P31, IRQ2 to P32. Ensure the ‘Enable’ tick box of IRQ1 and IRQ2 are checked, as shown
in Figure 4-48.

Software Components B %|& Pin Function QAN H R e
‘Type filter text ‘ |type filter text (* = any string, ? = any character) ‘ All >
v Zirbsp Ena.. Function Assignment Pin Num... Directi.. Remarks Comments
= r_bsp IRQO |7 P30/MTIOCA4B/TMRI3/POE8#/RXD1/SMISO1/SSCL1/TS2/1] 7 18 |
v % 8-Bit Timer IRQ1 [7 P31/MTIOCAD/TMCI2/CTS1#/RTS1#/551#/T51/IRQ1 17 |
* Config_TMRO ] 1rRQ2 7 Not assigned # Not assigi None
~ & Compare Match Timer ] ra3 # Not assigned # Not assigi None
= Config_CMTO ] IRQ4 7 Not assigned 7 Not assigi None
= Config_CMT1 [] 1rRQ5 7 Not assigned # Not assigi None
¥ & Interrupt Controller [] ras # Not assigned # Not assigi None
@ Config_ICU [ rQ7 7 Not assigned 7 Not assigi None
¥ X Ports ] NmI 7 Not assigned 7 Not assigt None

« Config_PORT
v & SCI/SCIF Asynchronous Mode
« Config_SCI1
v % SPI Clock Synchronous Mode (3-wire method)
« Config_SCI6
v % Continuous Scan Mode S12AD
@ Config_S12ADO

Pin Function Pin Number

Figure 4-48 Configure pin assignment - Config_ICU

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO0# and ANOOO are checked and Assignment column of AN0OO is P40, ADTRGO# is
P16 as shown in Figure 4-49.

Software Components 2 % s& Pin Function RANE R
Type filter text | ‘type filter text (* = any string, ? = any character) ‘ All v
v & r_bsp Ena.. Function Assignment Pin Num... Directi.. Remarks Commer A

= r_bsp ADTRGO# |# P16/MTIOC3C/MTIOC3D/TMO2/TXD1/SMOSI1/SSDAT/M| 7 24 |
v % 8-Bit Timer ANO0O [+ P40/AN0OO |7 75 |
= Config TMRO [] anNo01 # Not assigned 7 Not assigi None
v 2 Compare Match Timer [ AaNno02 # Not assigned # Not assigi None
= Config_CMTO [] ANOO3 # Not assigned 7 Not assigi None
= Config_CMT1 [] AN0O4 # Not assigned 7 Not assigi None
~ & Interrupt Controller [] AaNo05 # Not assigned 7 Not assigl None
« Config_ICU [] ANOOS # Not assigned # Not assigi None
v % Ports [] aNoo7 # Not assigned / Not assigi None
& Config_PORT [] aNO16 # Not assigned 7 Not assigi None
~ L SCI/SCIF Asynchronous Mode [] ANO17 # Not assigned # Not assigi None
@ Config_SCI1 [] ANnO18 # Not assigned 7 Not assigi None
v % SPI Clock Synchronous Mode (3-wire method) [] AND19 # Not assigned 7 Not assigi None
& Config_SCI6 [] ANO20 # Not assigned 7 Not assigi None
~ % Continuous Scan Mode S12AD [] ANO21 # Not assigned 7 Not assigi None
& Config S12AD0 [] ANo024 # Not assigned 7 Not assigl None
[ Aan025 # Not assigned # Not assigi None
[] ANO26 # Not assigned 7 Not assig None
[] VREFHO # Not assigned 7 Not assigi None
[] VREFLO # Not assigned 7 Not assigi None v
< >

Figure 4-49 Configure pin assignment - Config_S12AD0

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘felGenerate Code’ at location of Figure 4-50.

{85 SC_Tutorial.scfg 53 = =

Pin configuration

Figure 4-50 Generate Code Button
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If the Section Setting Dialog is displayed as shown in the Figure 4-51, Please check the box and click “Yes”.

The Console pane should report ‘Code generation is successful’, as shown Figure 4-52 below.

Section Setting X

The current project’s section settings (Build tool — Link option — Section settings) are not
compatible with newly generated codes, it is recommended to update the section settings.

Current section settings:
B_1,R_1,B_2,R_2,B,R,SU,51/4,PResetPRG/FFFE0000,C_1,C_2,C,C$DSEC,CSBSEC,CSINIT.CSVTBLCS
VECT,D_1,D_2,D,PPIntPRGW_1W _2,W,L/FFFE0100,EXCEPTVECT/FFFFFF80,RESETVECT/FFFFFFFC
New section settings:
SU,SI,B_1,R_1,B_2,R_2,B,R/0x00000004,C_1,C_2,C,C$* D*,W* L,P*/0xFFFE0000,EXCEPTVECT/OXFF
FFFF80,RESETVECT/OXFFFFFFFC

[Yes] to change section settings and generate code
[No] to keep current section settings and generate code
[Cancel] to cancel code generation

oo notshow again

Yes No Cancel

Figure 4-51 Section Setting Dialog

After execution, close Smart Configurator and return to CS +.

2 Console

Smart Configurator Output

Me4eoee01:
Me4ooe00l:
Me4606001:
Me46e6001:
Me4eoee01:
Me4ooe00l:
Me4606001:
Me4o06001:
Me4eoee01:
Me4ooe00l:
Me4606001:
Me4606001:
Me4eoee01:
Me4ooe00l:
Me4606001:
M@5606012:
Mes5e0e012:
Meceoeee2:
Me660e0e2:
M@3606004:
Meeeoeee2:

File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
Code

ENN T

generated:src\smc_gen\Config SCI6\Config SCI6.c
generated:src\smc_gen\Config SCI6\Config SCI6 user.c
generated:src\smc_gen\Config S12AD8\Config S12AD8.h
generated:src\smc_gen\Config S12AD8\Config S12AD6.c
generated:src\smc_gen\Config S12AD@\Config S12AD@ user.c
generated:src\smc_gen\general\r cg macrodriver.h
generated:src\smc_gen\general\r cg userdefine.h
generated:src\smc_gen\general\r_smc_entry.h
generated:src\smc_gen\general\r cg hardware setup.c
generated:src\smc_gen\general\r cg cmt.h
generated:src\smc_gen\general\r_cg tmr.h
generated:src\smc_gen\general\r_cg icu.h
generated:src\smc_gen\general\r cg port.h
generated:src\smc_gen\general\r cg sl2ad.h
generated:src\smc_gen\general\r cg sci.h
generated:src\smc_gen\r_pincfg\Pin.h
generated:src\smc_gen\r pincfg\Pin.c
generated:src\smc_gen\general\r smc interrupt.c
generated:src\smc_gen\general\r smc_interrupt.h
modified:src\smc_gen\r_config\r_bsp config.h
generation is successful:C:\WorkSpace\SC Tutorial\src\smc gen

Figure 4-52 Smart Configurator console

When code generation is executed, the startup files generated at the time of CS+ project creation are
replaced with those generated by Smart Configurator. Figure 4-53 the project tree after code generation. In
the next chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file

to the project.

Project Tree a2 x
: © 8 @&

= f% SC Tutorial (Project)*
#% RsF51405BxFN (Microcontroller)
Bl Smart Configurator (Design Tool)
A, CC-RX (Build Tool)
2> RX Simulator (Debug Tool)

&' Program Analyzer (Analyze Tool)
:T‘Hh

7-E] Build tool generated files

& SC_Tutorial.c
5[ ]] Smart Configurator

+ general
4Ll r_bsp

+ r_config

+ r_pincfg
+-|_l) Config_CMTO
+ Config_CMT1
+-|li Config_ICU

+ Config_PORT
+ Config_S12AD0
+ Config_SCI1
+ Config_SCl6
+- 1) Config_TMRO

Figure 4-53 Smart Configurator folder structure
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5. Completing the Tutorial Project

5. Completing the Tutorial Project

5.1

Project Settings

RAM rather than ROM addresses to
C variables. Click ‘OK’

e In the ‘Project Tree’ pane, select Project Tree o x
‘CC-RX (Build Tooly. The build 8 @ 8 |[@E
properties will appear in the main .
window. =] _E SC Tutorial (Project)*
.. #® RSF51405BxFN (Microcontroller)
.%8| smart Configurator (Design Tool)
CC-RX (Build Tool)
... RX Simulator (Debug Tool)
... Program Analyzer (Analyze Tool)
=Y File
e CS+ creates a single build | |% ;:;:m:eﬂy
. . ‘ T v Buil
configuration called ‘Default Build’ for Build mode
the prOjeCt ThIS has Standard COde Change property value for all build modes at once No
- v CPU
opt|m|sat|on tur‘ned on by default \nslruct}on set architecture ) ) RXv2 architecture(isa=mv2)
Uses single-precision floating-point operation instructions Yes(fpu)
Endian type for data Little-endian data(-endian=ittle)
Rounding method for floating-point constant operations round to nearest(round=nearest)
Handling of denormalized numbers in floating-peint constants Handles as zeros(-denomalize=off)
Precision of the double type and long double type Handles in single precision(-dbl_size=4)
Replaces the int type with the short type Ne
Sign of the char type Handles as unsigned char{-unsigned_char)
Sign of the bit-field type Handles as unsigned(-unsigned _bitfield)
Selects the enumeration type size automatically No
Order of bit-field members Allocates from right(-bit_order=right)
e Select the ‘Compile Options’ tab at | |% ;:-RX Property
the bottom of the properties window | | prrrmmmr=r 5]
¢ Language of the C++ source file C++{{ang=cpp)
pane Un7der Lang‘uage Of the C’ » Additional include paths Additional include paths[17]
source file’ select ‘C99(-lang=c99) > System include paths Syemincudepathsll]
as Shown OppOSIte : u:?i:i::i;;:he head of compiling units L::r;edf;?:n?;;T‘; head of compiling units[0]
Invalidates the predefined macro
Enables information-level message output No[-nomessage)
Suppresses the number of information-level messages
Undisplayed messages
Changes the warning-level m ges to information-level m 0 No
Changes the information-level m ges to warning-level o 0 No
Language of the C source file
Selects | of the C file.
Thiﬁrrll%ﬁgdes totth?a-las:gu?;\srfof the compiler.
Common Options ICompiIe Options I\ AssemhbleOptions X Link Options X Hex Output Options X Library Generate ¢
] Select the ‘Link Options’ tab at the - ss::«:nms«anadams SU.SIL.B_1.R_1.B_2.R_2.B.R/4.C_1.C_2.C.CS".D" W*.L.P*/FFFE0000.EXCEPTVECT/FF
) i > The specified section that outputs exterally defined symbols to the file The specfied section that outputs extemally defined symbols to the fie{0]
bottom of the properties window | | i — |
pane. Under ‘Section -> ROM to Oene
RAM mapped section’, add the three | e ... e s oo sasnret s smsmie
mappings as shown opposite. e e e e
\_ Common Options /_Compile Options | | Link Options | Hex Output Options | Library Generate Options
e These settings are easily added by Text Edit
clicking the button ‘..." and pasting
the following text into the dialog:
D=R
D 1=R 1
D 2=R 2
e This ensures that the linker assigns

Cancel Help
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o From the ‘Build’ menu, select ‘Build ™ SC _Tutorial - CS+ for CC - [Property]

Mode Settings""' Click ‘Duplicate File Edit View Project |Build| Debug Tool Window Help
and in the resulting ‘Character String & siat | L @&l Buila Project =

Input’ dialog, enter ‘Debug’ for the | —= = = =0 _ o ot ——
name of the duplicate Build Mode. IS S _g Peilet

Project Tree

% [t} 3 F f;} Rapid Build
= _ﬂ SC Tutorial (P =% Update Dependencies
9% RsF514058( )| Build SC_Tutorial

4 M &) Rebuild SC_Tutorial

Clean SC_Tutorial

(enuepy pewg £

Update Dependencies of SC_Tutorial
Set Link Order of SC_Tutorial...

Open the Optimization Performance Comparisen Tool for SC_Tutorial...

Stop Build Ctrl+F

Build Mode Settings...
Batch Build...

3 Build Option List

Selected build mode
Build mode list:

DefaultBuid

Character String Input

String:
Debug
b Coret ||t

e The new ‘Debug’ Build Mode will be | | == AL

added to the Build Mode list. Click N 05 e

‘Close’.  Now, in the main CC-RX | |+&

Property ~ window, under the e e

‘Common Options’ tab, click on the i e e s b ookt e o e

line containing ‘Build Mode’, click the e e ek Sl et

pull-down arrow and select ‘Debug’ Tt udueder ey

’ Selects the enumeration type size automatically No
from the pU”-dOWﬂ . Order of bit-field members Allocates from right(bit_order=right)
fssumes the bour:dar:,j allgnrnenlvalue for structure members is 1 7No(unpa§)7 — - L
:I:::rbmld mode name to be used during build.
Common Options | Compile Options | AssembleOptions /| Link Options / Hex Output Options / _Library Generate Options -

e In the ‘Frequently Used Options (for | “ Sfxieen dl 18] 1=

Compile)’  group, select  the Build mode Debug

‘ . . . 5 . Change property value for all build modes at once No

Optimization Level’ option and select | |, cru

‘0’ from the pull-down. We have NOW | | GumatFite Type md P

created a ‘Debug’ Build Mode with Dutput e bype Sxacute Modie( 020 Mockle Flel

Intermediate file output folder

imi 1 H v Frequently Used Opiions(for Compile)
nol code opFlmlsatlon and will be y Ad:tlmnalmyclude paths Additional include paths[17]
using the Build Mode to create and > Systeminclude paths System include paths[l]

. > Macro definition Macro defintion[0]
debug the prOjeCt Outputs debugging information Yes(-debug)

2(-optimize=2)
O{-optimize=0)

Optimization level
Outputs additicnal information for inter-module optimization

Optimization type 1[-optimize=1)
Qutputs a source list file 2[-optimize=2)
~ Freq y Used Oy Max(-optimize=max)
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All of the sample code projects
contained in this RSK are configured
with three Build Modes;
‘DefaultBuild’, ‘Debug’ and ‘Release’.
‘Release’ is created in the same way
as above; by duplicating ‘Default
Build’. ‘Release’ Build Mode leaves
code optimisation turned on and
removes debug information from the
output file.

To remove debug information from
the ‘Release’ Build Mode, in the ‘CC-
RX Property’ window, select the
‘Common Options’ tab at the bottom
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).

Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

From the menus, select ‘File -> Save
All' to save all project settings.

4, CC-RX Property al |2 |-
~ Build Mode
Build mode Release
Change property value for all build modes at once No
CPU
PIC/PID
~ Output File Type and Path
Output file type Execute Module(Load Module File)
Intermediate file output folder %BuildMode Name %
~ Freguently Used Opiions{for Compile)
Additional include paths Additional include paths[17]
System include paths System include paths[0]
Macro definition Macro defintion[0]
Outputs debugging information Yes|debug)
Optimization level 2(-optimize=2)
Outputs additional infarmation for inter-module optimization No
Optimization type Optimizes with emphasis on code size[size)
Outputs a source list file Nof-nolistfile)
Freguently Used Options(for Assemble)
~ Fregquently Used Options{for Link)
Using libraries Using libraries[0]
Yes (Qutputs to the output fie) DEBug)

Optimization type
Section start address
+ Freguently Used Options(for Hex Oulput)

Yes {Outputs to the output file-DEBug)

No(-NODEBug)

Additional Folders

Before new source files are added to
the project, we will create two

Project Tree a x

;. © 83

Jan.17.2022

additional folders in the CS+ Project | | = BRI, 0o s
Tl’ee °;5] Smart Confi ]u Rebuild SC_Tutorial
. . . CC-RX (Buil ;i
In the Project Tree pane, right-click P " faiia
. . = 9 :
the SC_Tutorial project and select D Program An; | Open Folder with Explorer
‘Add > Add NeW Categorya = _ﬂ%lﬂe . £l Windows Explorer Menu
H c_]‘ 2;".?”:?‘: Add M Add Subproject...
Lk Smart Cd gl Set SC_Tutorial as Active Project +B Add New Subproject...
[§] Save Project and Development Tools as Package... _l Add File...
f Paste Ctrl+V 1 Add New File...
#® Rename F2 || Add New Category
Property
Rename the newly-created ‘New [Project Tree 3 x|
Category’ folder to ‘C Source Files’. 5t @ 8@
Repeat these steps to create a new -.| # SC Tutorial (Project)*
category folder for ‘Dependencies’. & RsF514058xFN (Microcontroller)
c;'l Smart Configurator (Design Tool)
A, CC-RX (Build Tool)
& RX Simulator (Debug Tool)
¢ Program Analyzer (Analyze Tool)
5[ File
¥ ﬂJ Build tool generated files
‘ﬂ SC_Tutorial.c
¥ Smart Configurator
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h

Copy these files in to the src folder below the workspace and then follow the steps below.

« Move the ‘SC_Tutorial.c’ file from B % B - | sClutoral
‘C:\Workspace\SC_Tutorial’ to L Home | Share  View
‘C:\Workspace\SC_Tutoria|\SrC'. &« v P » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial
Name - Daten
7 Quick access et
Debug
I3 This PC DefaultBuild
[ Desktop Release _A
£ Documents £l &= -
; Downloads g dbsct.c
J’ Music g hwsetup.c
. _|intprg.c
&=/ Pictures j iodefine.h
B videos E] lowlvl.src
%5 Local Disk (C:) “Nowsre.c
=¥ Network g lowsrc.h
N | resetprg.c
j shrk.c
1 shrk.h
[ SC_Tutorial #5032, mtud
&) sC_Tutorial.mtpj

« Select SC_Tutorial.c on the project tree, Right- i ¢ X
click and select 'Remove from Project' to tos @
. . =/ % SC Tutorial (Project)”
exclude it from the project. 18 R5F514058xFN (Microcontrollen)

& Smart Configurator (Design Tool)
A, CC-RX (Build Tool)
2 RX Simulator (Debug Toel)

¢ Program Analyzer (Analyze Tool)

= File
@ ﬂ Build tool generated files
& -
_] SC_Tutorial.c| '} Compie
5[] Smart Config #
b CSourceFild [§* Open
) Dependenci [Z Open with Internal Editor...
% Open with Selected Application...
31 Open Folder with Explorer
&l Windows Explorer Menu
Add >
|E_1 Remove from Project Shift+Del

« Right-click on the ‘C Source Files’ folder and é"’ﬂesmcmgum H
select ‘Add’ -> ‘Add File...". '

...[] Dependencid  Add »I[ 2 AddFile.. |
"?]. Open Folder with Explorer :;:j Add New File...
5 Windows Explorer Menu |E| Add New Category
Remove from Project Shift+Del
y| Copy Ctrl+C
iy Paste Ctrl+V
Rename F2
Property
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» Select the files to be added (ascii.c, 8 |Add Eisting Fle
r_Okaya_|Cd.C, SC_TUtOI'IaD from C. « v 4 <« Workspace » SC_Tutorial » src » v Search src pel
\Workspace\SC_Tutorial\src. Organize > New folder E- o @
3 Quick access terne
smc_gen
B This PC 7 ascii.c
[ Desktop j r_okaya_lcd.c
Documents E SC_Tutorial.c
¥ Downloads
D Music
&= Pictures
ﬂ Videos
‘i Local Disk (C:)
=¥ Network
< >
File name: | "SC_Tutorial.c” "ascii.c" "r_okaya_lcd.c" v| C source file (*.c) ~
« Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the |EIEEEEEES
'Dependencies' folder « v 4 <« Workspace » SC_Tutorial » src » v Search src pel
Organize « Mew folder Bz~ ™ @
MName -
Note: Select the Header file (* .h; * hpp; * .inc). # Quick access amegen
B This PC " asciih
[ Desktop j r_okaya_lcd.h
Documents
¥ Downloads
D Music
&= Pictures
ﬂ Videos
‘i Local Disk (C:)
=¥ Network
< >
File name: ‘"r_okaya_\(d.h” "asciih" v| IHeaderfi\e(*‘h; *hpp; *inc) VI
« Make sure the project tree is the same as the Project Tree 2 x
screen shot.
2 2 &
S8 :{SC Tutorial (Project)*
... J™ RSF51405BxFN (Microcontroller)
.. % smart Configurator (Design Tool)
. A, CC-RX (Build Tool)
.2 RX Simulator (Debug Tool)
-1 Program Analyzer (Analyze Tool)
= j File
ﬂ; Build tool generated files
[#-L_|y Smart Configurator
L1} C Source Files
 ..&| SC_Tutorial.c
& asciic
: c_] r_okaya_lcd.c
B 1 Dependencies
. '_I r_okaya_lcd.h
"_l ascii.h
R20UT5029EG0100 Rev.1.00 IQENESAS Page 44 of 70

Jan.17.2022



Renesas Starter Kit for RX140 5. Completing the Tutorial Project

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area for include near the top of the file:
/* Start user code for include. Do not edit comment generated here */
#include "platform.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the type define.
/* Start user code for type define. Do not edit comment generated here */
typedef char char t;

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r smc _entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R_LCD_Init();

/* Displays the application name on the debug LCD */
R_LCD Display (0, (uint8 t *)" RSKRX140 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R LCD Display (2, (uint8 t *)" Press Any Switch ");
while (1U)

{

}

Indentation is lost when the code described in this manual is pasted into the CS+ source file. Also check that the
pasted code is correct.
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in section
4.6.7. In the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI6’ and open the file ‘Config_SCI6.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the ‘Config_SCI6_user.c’ file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s sci6 txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:
static void r Config SCI6 callback transmitend(void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

s _sci6_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

J Rk Kk kA KA A Kk ki hhh kA A AAAA A KA Kk ok hhh kA AAA KA KA KKKk k ko k ok kA XA KA K& &K kK kkkokokx

* Function Name: R_SCI6_ SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/
MD STATUS R_SCI6_ SPIMasterTransmit (uint8 t * const tx buf, const uintl6_ t tx num)

{
MD STATUS status = MD OK;

/* Clear the flag before initiating a new transmission */
s_sci6_txdone = FALSE;

/* Send the data using the API */
status = R Config SCI6_SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s_sci6_txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI6 SPIMasterTransmit

KKK KK KKK K K K KK K K K K K K K K K K R K K R R R kK R R R K K R R R kK R R R R K R R R R R R R R R R R R R R kR ok kK /

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 TMR Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in section 4.6.2. In the CS+ Project
Tree, expand the ‘Smart Configurator\Config' TMRO\Config_ TMRO.h’ and insert the following code in the user
area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_TMR MsDelay (const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ TMRO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t s one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config TMRO_cmiaO_interrupt function and insert the following line in the user code
area:

static void r Config TMRO cmiaO interrupt (void)
{
/* Start user code for r Config TMRO cmia0O_interrupt. Do not edit comment generated here */

s_one _ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

KKk ok ok ok K KA A A K Kk ko k k ok ok ok kR A A A K KKk ks k ok ok ok kR A A A A KK Kk ko k ok ok ok kA A A K K Kk ok ko kR ok ok ok ok ok

* Function Name: R_TMR MsDelay

* Description : Uses TMRO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
**********‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k************************/
void R _TMR MsDelay(const uintl6é t millisec)

{

uintlé t ms count = 0;

do

{
R Config TMRO Start();
while (FALSE == s one _ms_delay complete)
{

/* Wait */

}
R _Config TMRO_Stop();
s_one_ms_delay complete = FALSE;
ms_count++;

} while (ms_count < millisec);

}

KKK KKk K K K Kk K K R K K kK K K K R kK R R R kK R R R ok K R R R kK R R R kK R Rk Rk R Rk Rk R K Rk Rk kK

End of function R TMR MsDelay
*******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. The program will display
‘RSKRX140 Tutorial Press Any Switch’ on 3 lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx140def.h
-r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

The switch code uses interrupt code in the files Config ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config ICU.c, Config ICU_user.c, Config CMTO0.h, Config_ CMTO0.c, Config CMTOQ_user.c,
Config_ CMT1.h, Config_ CMT1.c, and Config_ CMT1_user.c, as described in section 4.6.3 and section 4.6.4.
It is necessary to provide additional user code in these files to implement the switch press/release detection
and de-bouncing required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);
void R _ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the ‘Config_ICU.c’ file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

VAREEEEEEE SRR R RSt AR Rt EEEE R R Rt

* Function Name: R _ICU IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU IRQ is set to

* falling edge triggered, otherwise 0.

* Arguments : uint8 t irg no

* Return Value : 1 if falling edge triggered, 0 if not
*******************************************************************************/

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)
{
uint8_t falling edge trig = 0xO0;
if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)

{
falling edge trig = 1;
}

return (falling edge trig);
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R_ICU_IRQIsFallingEdge

LR EEEEE RS SRR EEE R EEE R EEE R EE Rt

VAREEEEEEE SRR EE RS AR EE Rt EEE Rt EE Rt

* Function Name: R_ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k**********************~k~k~k~k~k~k~k~k~k~k***********************/

void R ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;
}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R ICU IRQSetFallingEdge

*******************************************************************************/

VARAEEEEEE RS EEEAEEEEE AR Rt EEEE Rt EE Rt

* Function Name: R ICU IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/
void R ICU IRQSetRisingEdge (const uint8 t irq no, const uint8 t set r edge)
{
if (1 == set_r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;
}
else
{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;
}
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R _ICU_ IRQSetRisingEdge

LR R EEEE RS SRR EE SRR EE AR EEE Rt EEE Rt

/* End user code. Do not edit comment generated here */
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Open the ‘Config_ICU _user.c’ file and insert the following code in the user code area for include near the top
of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg1_interrupt:

/* Start user code for r Config ICU irgl interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg2_interrupt:

/* Start user code for r Config ICU irg2 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.4.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMTO0’ folder and open the ‘Config_ CMTO_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_ CMTO_user.c’ file insert the following code in the user code area inside the function
r_Config_ CMTO_cmiO_interrupt:

/* Start user code for r Config CMTO cmi0O interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMTO_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_ CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file and insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil_ interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In section 4.6.8 we configured the ADC to be triggered from the ADTRGO0# pin, SW3.
In this code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include "r smc entry.h"
finclude "r okaya lcd.h
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Init();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSKRX140 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R_Config S12AD0_Get_ ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then add the definition for the switch call-back, get_adc and lcd_display_adc functions adding at the below of

the main function, as shown below:

KKK A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A Ak A A Ak kA Ak kA, Kk

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/
static void cb switch press (void)
{

/* Check if switch 1 or 2 was pressed */

if (g_switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))

{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}
}

/******************************************************************************
* End of function cb switch press

*‘k‘k‘k*‘k*‘k‘k*‘k*‘k*‘k*‘k**‘k*‘k*‘k‘k***‘k*‘k‘k‘k‘k*‘k‘k‘k*************‘k*‘k************************/
/******************************************************************************

* Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintlé t adc value

******************************************************************************/
static uintlé t get adc (void)

/* A variable to retrieve the adc result */
uintlé_t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R_S12AD0_SWTriggerStart () ;

/* Wait for the A/D conversion to complete */
while (FALSE == g adc_complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R_S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R Config S12AD0 Get ValueResult (ADCHANNELO, &adc result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R Config S12AD0 Start();

return (adc_result);

}

/******************************************************************************

* End of function get adc
******************************************************************************/
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintlé_t adc_result)
{

/* Declare a temporary variable */
char t tmp;

/* Declare temporary character string */
char t lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) ((adc_result & 0x00F0) >> 4);

lcd buffer[7] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char_t) (adc_result & 0x000F);

lcd buffer[8] = (tmp < 0x0A) ? (tmp + 0x30) : (tmp + 0x37);

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);

}

/******************************************************************************

* End of function lcd display adc

LR EEE RS e EE AR R R R

In the Project Tree, expand the ‘Smart Configurator\Config  S12AD0O’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,

resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R _S12AD0_SWTriggerStop (void);

/* End user code. Do not edit comment generated here */
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Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStart (void)
{
IR(S12AD, S12ADIO) = 0U;
IEN (S12AD, S12ADIO) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0_ SWTriggerStart

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***********************/

VAREEEEEEE RSt EEEE Rt R R EE Rt EEEEE Rttt EEE Rt

* Function Name: R _S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R S12AD0_SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN(S12AD, S12ADIO) = 0U;
IR(S12AD, S12ADIO0O) = 0U;

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0 SWTriggerStop

LR EE Rt AR R R EE R e R R R EEEE Rt EEEEE R R Tt

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0_user.c’ and insert the following code in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r Config S12AD0_interrupt (void)
{
/* Start user code for r Config S12AD0_interrupt. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

-r_rsk_debug.c

-r_rsk_debug.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R _SCI1 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config_ SCI1’ folder and open the file ‘Config_SCI1.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI1 AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI1_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s scil txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI1_callback_transmitend function:

static void r Config SCI1 callback transmitend (void)
{
/* Start user code for r Config SCI1 callback transmitend. Do not edit comment generated here */

s_scil txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area
inside the r_Config_SCI1_callback_receiveend function:

static void r Config SCI1 callback receiveend(void)

{

/* Start user code for r Config SCI1 callback receiveend. Do not edit comment generated here */

/* Check the contents of g rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI1 receive buffer and callback function again */
R Config SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/‘k‘k‘k‘k‘k‘k*************************************************************************

* Function Name: R SCI1 AsyncTransmit

* Description : This function sends SCI1 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

***********************:********:**********************************************/
MD_STATUS R_SCI1 AsyncTransmit (uint8 t * const tx buf, const uintl6_t tx_ num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s _scil txdone = FALSE;

/* Send the data using the API */
status = R Config SCI1 Serial Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s_scil txdone)
{
/* Wait */
}
return (status);

}

/*******************************************************************************

* End of function R SCI1 AsyncTransmit

R T R R T R R S
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5.6.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to above the ‘main’ function:

#include "r smc entry.h"
#include "r okaya lcd.h"
finclude "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI1.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintlé_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6é t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc count = 0;
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Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH TInit();

/* Set the call back function when SW1l or SW2 is pressed */

R_SWITCH_ SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)'" RSKRX140 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI1 receive buffer and callback function */
R Config SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI1 operations */
R Config SCI1 Start();

while

{

(10)

uintlé_t adc_ result;

/* Wait for

if
{

}

/* SW3 is directly wired into the ADTRGOn pin so will

(TRUE == g adc_ trigger)

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s_adc_count */
if (16 == (++s_adc _count))
{

s_adc_count = 0;

}
/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

/* Reset the flag */
g_adc_trigger = FALSE;

cause the interrupt to fire */

else if (TRUE == g _adc_complete)

{

}

/* Get the result of the A/D conversion */

R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s _adc_count */
if (16 == (++s_adc _count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc count, adc result);

/* Reset the flag */
g_adc_complete = FALSE;

else

{
}

/* do nothing */

user requested A/D conversion flag to be set

(SW1 or SwW2) */
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Then, add the following function definition in the end of the file:

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

*

*

Function Name : uart display adc
Description : Converts adc result to a string and sends it to the UARTI1.

* Argument : uint8 t : adc_count

*

*

uintlé_t: adc result

Return value : none

LR EEEE RS e EEE AR R e R R

static void uart display adc (const uint8 t adc_count, const uintlé_t adc_result)

{

}

/* Declare a temporary variable */
char t tmp;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

tmp = (char_t) (adc_count & 0x000F) ;

uart buffer([4] = (tmp < 0xO0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0xO0F00) >> 8);

uart buffer([14] = (tmp < O0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) ((adc_result & 0x00F0) >> 4);

uart buffer([15] = (tmp < O0x0A) ? (tmp + 0x30) : (tmp + 0x37);
tmp = (char t) (adc_result & 0x000F);

uart buffer[16] = (tmp < O0xO0A) 2 (tmp + 0x30) : (tmp + 0x37);

/* Send the string to the UART */
r debug print (uart buffer);

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

* End of function uart display adc
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. Connect the RSK G1CUSBO port
to a USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will
be installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &
LPT)" as 'RSK USB Serial Port (COMx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (Baud Rate:
19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).
When any switch is pressed, or when ‘¢’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result
to the PC terminal program via the SCI1.
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5.7 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI1.h"
#include "rskrxl40def.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R_LCD Tnit();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)" RSKRX140 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI1 receive buffer and callback function */
R Config SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCIl1 operations */
R Config SCI1 Start();

while (10)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2) */
if (TRUE == g_adc trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);
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/* Increment the s _adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */

uart display adc(s_adc_count, adc result);

/* Reset the flag */

g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc complete)
{

/* Get the result of the A/D conversion */

R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDS0-3
* Argument : uint8 t count

* Return value : none

******************************************************************************/
static void led display count (const uint8_t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);
LEDLl = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8_t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) ? LED ON : LED OFF);

}

/**************************************~k***************************************

* End of function led display count
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in section 6. The code will perform the same

but now the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

6. Debugging the Project

e In the ‘Project Tree’ pane, right-click the
‘RX Simulator (Debug Tool).  Select
‘Using Debug Tool -> RX E2 Lite’.

Project Tree a x

: © 8 @

=i SC Tutorial (Project)*
i % R5F51405BxFN (Microcontroller)
... % Smart Configurator (Design Tool)
.4, CC-RX (Build Tool)

(MAX 200mA) to ‘Yes'.

o All other settings can remain at their
defaults.

= ator (Debuqg
-..(¥ Program Analyzer (A Using Debug Tool » RX E2
&-[F File -
jﬂ: Build tool genera G| Propery | L
[l Smart Configurator RXE1(Serial)
@-Ll) CSource Files RX E20(Serial)
- || Dependencies RX Simulator
e Double-click ‘RX E2 Lite (Debug Tool)' to e—
display the debugger tool properties. -
‘ , . =% RXE2 Lite Property
Under ‘Clock’, change the main clock e an
frequency to 8MHz, Communications Size of internal ROM[KBytes] 128
method ‘FINE’ and operating frequency to Size of internal RAM[KBytes] 32
48MHZ.’ . éi:‘:ukt DataFlash memory[KBytes]
e Under ‘Connection with Target Board’, Msin clock source EXTAL
change ‘Power target from the emulator. |§:;;";;ﬁf;j“;jg°lmﬂfl -

Allow changing of the clock source on wnting internal flash memory No
~ Connection with Emulator
Emulator serial No.

~ Connection with T: Board
Power target from the emulator.(MAX 200mA) Yes

Supply vo /

IZ:-v'nur'u::atu:r: method FINE

FINE baud ratelbps) 500000

e Connect the E2 Lite to the PC and the
RSK E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.

e From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.

Click the ‘Go’ button or press F5 to begin the program from the current program counter {E:l
position. It is recommended that you run through the program once first, and then continue to el

the Tutorial manual to review the code.

R20UT5029EG0100 Rev.1.00 :{EN ESNS Page 65 of 70

Jan.17.2022




Renesas Starter Kit for RX140

8. Additional Information

8. Additional Information

Technical Support

Help

For details on how to use CS+, refer to the help Window | Help|
file by opening CS+, then selecting Help > Help . |@
Contents from the rx140 menu bar. - °

BHLEE NS

—
(Pn]
S

Open Help for Main window
How to Access Help
One Point Advice...

Tutcrial

Browse Renesas Electronics Microcontrollers Wek

Privacy Settings...
Detail Version Information...
Check for Updates...

Launch License Manager...

About...

Fi

For information about the RX140 group microcontroller refer to ‘RX140 Group User’s Manual: Hardware'.

For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details
America: techsupport.america@renesas.com

Europe: https://www.renesas.com/eu/en/support/contact.html

Global & Japan: https://www.renesas.com/support/contact.html

General information on this product can be found on the Renesas website at:

https://www.renesas.com/rskrx140

General information on Renesas microcontrollers can be found on the Renesas website at:

https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe GmbH.

© 2022 Renesas Electronics Europe GmbH. All rights reserved.
© 2022 Renesas Electronics Corporation. All rights reserved.
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